13. Detecting recombination in viral sequences

Analysing example sequences to visualize recombinatbion

There are several sets of aligned sequences which will be used for the exercises. These are all included on the book accompanying disc.

1. File “A-J-cons-kal153.fsa”. A single recombinant HIV-1 strain (KAL153), aligned with 50% consensus sequences derived for each HIV-1 subtype (proviral LTR-genome-LTR form).

2. File “A-J-cons-recombinants.fsa “. A set of multiple recombinant HIV-1 sequences in Fasta-format, aligned with 50% consensus sequences derived for each HIV-1 subtype (proviral LTR-genome-LTR form).

3. File “2000-HIV-subtype.fsa”. A set of reference HIV virtually complete genome sequences aligned in Fasta-format (virion RNA R-U5-genome-U3-R form). This set represents the Los Alamos International HIV-database year 1999/2000 official reference set and uses the "group" feature of Simplot (see below).

4. File “Entero-B-group.fsa”. A set of aligned Enterovirus B species complete genome sequences in Fasta format.

5. Files “A-J-cons-kal153.nex” and “A-J-cons-recombinants.nex”. Two examples of Nexus-formatted sequence alignments to demonstrate the use of Splitstree.

Exercise 1: working with Simplot.

In this exercise we will use Simplot and it’s basic properties.

1. To start Simplot, select the program from its group on the Start Menu in windows or double-click on the Simplot icon in the folder you placed the program in. 

2. The program will start with a window as shown in figure XIII.15a. Use the file menu to Open an alignment file. Simplot can read a large number of different sequence alignment formats, specifically those included in Don Gilbert’s Readseq code. For this demonstration, open the file “A-J-cons-kal153.fsa” (the .fsa extension may or may not be visible, depending on the settings of your computer). This file contains an alignment of the CRF03-AB strain Kal153 and 50% consensus reference sequences for subtypes A-J. You see a treelike graph as in figure XIII.15b. 

3. The graph is similar to Windows Explorer. The Sequences are the terminal branches and each sequence is contained within a group, with the same name as the sequence by default. Groups are used primarily when you wish to generate consensus-sequences on the fly, and we will cover them in another exercise. The groups and sequences both have checkboxes. Unchecking these cause the group or sequence to be excluded from the analyses, without generating any changes into the original file. 

4. Now try to move the “KAL153”-sequence to the top of the tree by selecting it and pressing the “Move up” button sequentially. The graph should look like figure XIII.16a.

5. Now we go to the analysis part: near the bottom of the window are four tabs. Click on  “SPlotPage”.

6. You have now arrived on the page where the Similarity plots are performed. The other tabs, “SeqPage
”, “Bootscan” “Findsites” and “Histogram” are the input-page (where we just arrived from), the Bootscanning analysis page and the phylogenetically informative site -analysis page. The bootscanning analysis will be covered later, and the Simplot documentation describes the last 2 options.

7. To do a first analysis, go to the “Commands”-menu and select “Query” and “KAL153” on the pop-up list. You will see that this list reflects the sequences in the order that was determined in the “SeqPage” window. This first operation determines which of the aligned sequences is compared to all the others (Figure XIII.16b). To actually do the analysis, go to the “Commands”-menu once again, and click on “DoSimPlot”. The result should be similar to figure XIII.17a.

8. You will see that the analysis will indicate that the KAL153 strain is a recombinant of subtypes A and B, as reflected by the legend key. The analysis was run by the Simplot default values, and you can see that these are a window of 400 and a step size of 20 bases. These values can be changed by clicking on the vales in the lower frame of the window or from the “Options - prefernces”-menu. 

9. There are many parameters that can be changed from the “Options - preferences” menu.To examine some of the effects of the different options, play around with the  parameters: for example, if you select the “Jukes-Cantor correction”, you will see how the distances will increase a little, which is exactly what is expected from employing evolutionary correction models. If you change the window size to 800 bases, you will see how this affect the resolution of the plot (window and step size plus the consensus model are set from the bottom panel of the software . Compare the plot to the composite similarity plot shown in XIII.10. Other useful things that can be changed are the region of the vertical axis shown, whether or not similarity or distance (actually dissimilarity) is plotted and whether or not gap-regions should be excluded from the analysis (usually recommended). Consult the Simplot documentation (accessible from the “Help” menu) for more information about the different options.

10. Now go back to the “SeqPage”-tab and move the sequences so that you only have A, B, C and KAL153 above the “Hidden below this line” separator. Then go back to the “SPlotPage” tab. When you now do the analysis, you will see that its will be quite easy to pinpoint the actual recombination breakpoints. In fact, you can actually click on the breakpoints (or anywhere on the curves), and a pop-up window will show you which position in the alignment the breakpoint is located (Figure XIII.17b.

11. The next thing to test is Bootscanning. Make sure at the “SeqPage” tab that you still have only the four sequences from section 11. Included in the analysis. Then click on the Bootscan tab. This will take you to the bootscan window, and some of the options will be changed in the menu. All of these are related to the Phylip package and should be self-explanatory to anyone that has used the DNA-analysis programs of the package. For example, the tree algorithm (figure XIII.18a), distance model, and number of bootstrap replicates can be set. After setting the query sequence to “KAL153” you can start the analysis from the “Commands”-menu by selecting  “Do Bootscan”. The analysis starts, and this is reflected by a running dialog in the bottom right corner showing which tree is being processed. Simultaneously, the plot grows on the screen. The analysis is fairly slow, but can be stopped from the “Stop Bootscan” button in the right lower corner. It is not possible to continue the analysis after prematurely stopping it. When the Bootscan is finished, you can compare the resulting plot to figure XIII.10.

Exercise 2: mapping recombination with Simplot

In this exercise we will map the structure of four HIV-1 recombinant strains shown in the table below. You will find these sequences in the file “A-J-cons-recombinants.fsa” on the data disc.





Subtypes

Breakpoints

SE7812


UG266


VI1035


VI1310


You can record the results of your analysis in the table above. There is a key to the structures in the last reference of this chapter.

1. To start the analysis, open the file “A-J-cons-recombinants.fsa”. Use the skills that you learned from exercise 1 to map the recombination breakpoints in the sequences

2. Hints: a) analyse the recombinants one-by-one using the “Hide” feature. b) get a first idea of the subtypes of the parental sequences with all reference sequences and a relatively large window size (600-800), then fine-map the recombination breakpoints with only the parental sequences and a smaller window size (300-400).

3. To verify the results you can export the identified regions from Simplot and create trees from them using Phylip and Treeview as has been demonstrated in earlier chapters of this book. To export a region of an alignment from Simplot, first record the region of interest (map the breakpoints). Then go to the “File” menu and select “Save slice of alignment as..” (Figure XIII.19a; here the KAL153 sequence is used as an example). In the following dialogue, indicate the region of the alignment that you wish to save in a separate file (please note that only the active sequences are included in the exported slice). After clicking on “Ok”, give the file a name and save it where you prefer. Note that you can select the format of the alignment from this dialogue. For Phylip, you will need to select the “Phylip interleaved” format. PLEASE NOTE: Phylip only recognises MS-DOS type paths and filenames, so stick to the 8.3, no spaces or special characters- rules. Hint: this feature of Simplot is quite convenient, since it can also be used as an all-purpose sequence alignment format converter. It is based on the Readseq algoritm by Don Gilbert.

4. Try this type of analysis on some of the sections that you have identified as belonging to different subtypes using Simplot.

Exercise 3: Using the “groups” feature of Simplot

A limitation of Simplot is that it can only analyse 26 individual sequences at any time. This is due partly to memory constraints, but also comes from the “group” feature. This is a way of specifying groups of sequences within an alignment that are then used to calculate consensus sequences on the fly. The way that this is done is by adding an extra string of characters to the beginning of an alignment file. These are put on a “sequence-line” of their own before all the other sequences in the alignment, and there must always be EXACTLY as many characters on the line as there are sequences in the alignment. The group-characters sequence is named “Simplot”. Below is an example of such a group-specifying line in the beginning of a alignment:

>Simplot

AAAABBBBCCCCCDDDDFFFFFFGGGGHHHJJKKEEEEXXXXYYZZZQQU

U

>A.KE.94.Q23

TGCCTTGAGTG-CTTCAAGTAGTGTGTGCCCGTCTG-TTGTGTGACTCTG

GTAACTAGAGATCCCTCAGACCACTCTAGACGGTGT-GAAAATCTCTAGC

AGTGGCGCCCGAACAGG-GACTCGAAAGC-GAAAGTT-------------
This fasta-formatted alignment contains 51 sequences, as reflected by the 51 characters in the Simplot groups-line. The different letters in the line reflect the groups, so that each letter specifies one sequence in the alignment, in order of occurrence. In the above example, we can see that the first four sequences of the alignment belong to a group called “A”, the next four to a group called “B” and so on. To specify groups, all the standard letters of the iso-latin alphabet can be used, but no other characters. Hence the 26-group/single sequence limitation. However, there is no limitation to how many sequences could be in a group (except memory). Unfortunately, the group sequence must be added by hand editing of an alignment text file.

1. To start the exercise, open the file “2000-HIV-subtype.fsa” in Simplot and compare the “SeqPage” view to the above example. This file contains exactly the groups that are specified in the above example (Figure XIII.20a).

2. Scroll up and down in the window. You will see how the program has grouped all the sequences as specified above. 

3. If you scroll all the way to the bottom of the window, there are six groups called E, X, Y, Z, Q and U (Figure XIII.20b). These contain reference sequences for the currently recognised four circulation recombinant forms (CRF01-CRF04) of HIV-1 and two pending candidates. Since the predetermined group feature of Simplot only allows one character to designate the group, we must now change the names interactively by using the buttons to the right to reflect the real names and keep track of the sequences.

4. Change the names of the groups as follows: E -> CRF01-AE, X->CRF02-AG, Y-> CRF03-AB, Z-> CRF04-cpx, Q-> CRF05-DF and U-> CRF06-cpx.

5. You will also notice that the F subtype actually consists of two groups, the F1 and F2 sub-subtypes. We will split these into two groups. First rename the F group F1. Next, create a new group using the buttons on the right, name it F2 and move it next to the F1 group. Select the F2-sequences one by one and move them to the new F2 group using the buttons to the right or by dragging and dropping (Figure XIII.20c).

6. Now move all other CRFs except CRF03-AB below the “Hide”-line, switch to the SPlotPage tab and do a default parameter analysis with window settings of 400/20 and CRF03-AB as the query. You will see that the program by default calculates a 50% consensus for the groups and plots the similarity values to that consensus. By clicking on the consensus panel in the lower part of the window, you can change the type of consensus that is used in the analysis. Figure XIII.21 shows results of analyses with different types of consensus models (see the For documentation for more details).

7. Experiment with the other groups in the alignment to see how the group function works. Hint: create new groups for individual sequences to study intrasubtype variation.

Exercise 4. Studying Enterovirus B Species recombination.

The B species of enteroviruses contains many viruses that have classically been viewed as different entities based on their antigenic cross-reactivity and have accordingly been named as different serotypes, i.e. viruses. Lately, however, genetic studies have revealed that the new species nomenclature is even more appropriate than was originally anticipated. This realisation comes from recent evidence that indicates that this group of viruses are highly recombinogenic, and that, indeed, there is clear evidence of recombination between the serotypes in all of the fully sequenced B species representatives. 

Studying recombination in the enterovirus B species is less straightforward than recombination of HIV-1 subtypes. The main reasons for this are that there are no clear subtypes within the B species and that the different serotypes have diverged more than the HIV-1 subtypes in certain regions of the genome.

Since there seems to have been multiple overlapping recombination events within the enterovirus B species serotypes, its is difficult to tell in which order the recombination events have occurred. However, there is ample evidence of the events. In this exercise some of these events will be studied using Simplot.

1. Start Simplot and open file “Entero-B-group.fsa” from the book datadisc.

2. Set the window settings to 400/20 and uncheck the “Jukes-Cantor” distance correction from the “Options” menu.

3. Cycle through the data set using one strain at a time to explore the similarity relationships. You will note that each time that the strain-name beginning is the same (i.e. the strains belong to the same serotype, CBV4 and CBV4-E2, CVB3 and CVB3-Woodruff, ECHO9B and ECHO9H) the similarity of the viruses is similar in the 5’-half of the genome (up to positions 3500-4000). This is logical, since the antibodies/sera that are used to serotype viruses recognise the capsid region which is coded by the 5’-region of the genome. However, there is no such relationship between the 3’-half of the genome. In this region different similarity-relationships exist. This is an indication of recombination.

4. An especially striking example of recombination is the CBV3-Woodruff virus. Go to the “SeqPage” tab and create a new group called “Species-B” and move all other strains to this group except for ECHO9H, CAV9, CBV1 and CBV3. Move the empty group labels under the “Hidden below this line” marker (Figure XIII.22a). Explore the relationships between the strains (Figure XIII.22b). Which virus is closest to CBV3-Woodruff in the 3’-half of the genome?

5. Do a bootscan using the CBV3-Woodruff strain as query. Compare the result to the Simplot analysis from the previous point.

Exercise 5. Using Splitstree to visualise recombination

Splitstree is a program that deduce not only bifurcating evolutionary relationships, but also networks, i.e. situations where both evolution by accumulation of point mutations and horizontal transfer between lineages (i.e. recombination) takes place. In this exercise we will explore a few such situations.

1. Start Splitstree by clicking on the program icon (or from the Windows Start Menu, if you have added it there).

2. Open file “A-J-cons-Kal153.nex”.

3. Splitstree produces a split-decomposition phylogenetic analysis of the relationships between the subtype reference sequences and the CRF03-AB recombinant strain. Compare the result with figure XIII.11. The analysis correctly indicates that the Kal153 strain is related to both subtypes A and B of HIV-1. The relationship to subtype D is also close, which is a reflection of the relatively recent separation of the B and D subtypes.

4. Now open the file “A-J-cons-recombinants.nex” containing many recombinant sequences together with the same subtype consensus reference sequences as in the previous point.

5. As with the Kal153 strain, Split decomposition analysis indicates multiple possible branching orders, as shown by the network-like tree structure (Figure XIII.23a).

6. With Splitstree, it is possible to select which of the sequences, or taxa, are included in the analysis. Open the “Options” menu and select “Taxa”. This will open a window showing a list of the sequences in a panel with the heading “Active” (the window may open behind other program windows). These are the taxa included in the analysis. Move all the recombinant viruses into the second panel with the heading “Hidden” by double-clicking on them one-by-one (Figure XIII.23b). Then click on the “Apply” button to recalculate the tree using the subtype consensus reference sequences only. Now the tree will be quite similar to what would be generated by ordinary phylogenetic methods (Figure XIII.24a ; b: Phylip Kimura 2-parameter Neighbour Joining tree). 

7. Move each of the recombinant sequences one-by-one from the “Hidden” panel into the “Active” panel and apply the analysis, which will indicate the recombinant structure of the sequences (Figure XIII.24c). Compare the results with those of exercise 2 and the key found in the last reference of this chapter.

Summary

In the first part of this chapter some of the basic mechanisms of viral recombination have been described and viral sequences have been used as a model to demonstrate how recombination can be detected and studied using sequence data. The requirements, theoretical basis, techniques and some applications for detecting recombination in sequence data were also discussed with examples given in a separate section of the chapter.

In the second part of the chapter, practical exercises with step-by-step guidance for downloading and installing software to detect and analyse recombination was given. Several examples using real sequence data were given to demonstrate how recombination can be detected and visualised in practice.

After reading the chapter the reader will have a basic understanding of the mechanisms leading to recombination in many viral species, and will have acquired skills to be able pursue analysis of own data. While not all of the properties of the software can be described in a single chapter of this book, the help-files and manuals that come with the packages can provide all further necessary information. In addition, the literature list sited is another valuable source of information and is a highly recommended reading list.

Mika Salminen, Ph.D. In Helsinki, Finland, October 22, 2000

Links to downloading the software used in this chapter:

Simplot:
http://www.med.jhu.edu/deptmed/sray/download/
Splitstree:
http://www.mathematik.uni-bielefeld.de/~huson/splitstree3/Splits31.zip
Phylip:
http://evolution.genetics.washington.edu/phylip/getme.html
MS-Windows

Tcl/Tk: 
ftp://www.scriptics.com/pub/tcl/tcl8_0/
Treeview:
http://taxonomy.zoology.gla.ac.uk/rod/rod.html
Bioedit:
http://www.mbio.ncsu.edu/RNAseP/info/programs/BIOEDIT/bioedit.html
Clustal X:
ftp://ftp.ebi.ac.uk/pub/software/dos/clustalw/clustalx/clustalx1.8.msw.zip
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Key to recombinant strain structures:

Strain

Parental Subtypes

Breakpoints**



SE7812
CRF02-AG


2480, 3420, 4360, 5290, 5430, 

5770, 6150, 6550, 8690, 9090,

9510.

UG266
AD



5430, 6130, 6750, 9630.

VI1035
CRF02-AG/C (AGC)
1800, 2200, 5840, 8920**

VI1310
CRF06-DF


2920, 3640, 4300, 5260, 6100.


*
There may be some variation in the exact co-ordinates 

depending on the window settings used.


**
These are the breakpoints between CRF02-AG and the subtype 

C segments.

